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Introduction to the RealAudio
Player Plus

Welcome to the RealAudio Player Plus by Progressive Networks. The
RealAudio system is the premier real-time audio delivery system for the
Internet.

Using the RealAudio Player Plus, you can listen to thousands of hours of live
and pre-recorded clips, including sporting events, live radio stations, news,
music, and lectures. In addition, the RealAudio Player Plus includes several
different RealAudio Player Plus components and provides access to a
customized Timecast World Wide Web site.

If you have not already installed the RealAudio Player Plus, please do so now.
The installation takes just a couple of minutes. Installation instructions start on
page 8.

For more information, refer to our web site: http://www.realaudio.com.
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RealAudio Player Components

In addition to the RealAudio Player Plus, three different special-purpose
RealAudio Player Plus components are installed on your computer. The
components work with different elements within World Wide Web pages to
deliver RealAudio sound in a variety of ways. The RealAudio Player Plus
components are:

RealAudio Plug-in The Plug-in provides access to RealAudio
programming and extends the audio capabilities of
your Netscape browser (Netscape Navigator 2.0 or
later).

RealAudio Control
for ActiveX

The Control provides access to RealAudio
programming and extends the audio capabilities of
your Internet Explorer 3.0 browser and Visual Basic
applications.

RealAudio Xtra for
Shockwave

The RealAudio Xtra for Shockwave provides
RealAudio programming within a Macromedia
Shockwave movie.

Timecast: the RealAudio Guide

Timecast (http://www.timecast.com) enables you to customize your own daily
news broadcast with time-sensitive audio content on the Internet. The
cornerstone of Timecast is the Daily Briefing feature, which allows you to
build a custom newscast with stories from well-known news and entertainment
organizations such as ABC, c|net, Entertainment Tonight, CBC, Fortune, Web
Review, ComputerWorld, Industry Net, TST-Sport, and Webactive.

Refer to “Customizing Your Timecast Page” on page 12.
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About this Manual

This documentation provides instructions for the installation, operation, and
customization of the RealAudio Player Plus. It assumes that you have a basic
knowledge of your operating system and your World Wide Web browser, such
as Netscape Navigator or Internet Explorer.

Documentation Conventions

The following conventions are used in this manual:

Bold text indicates the names of commands you should select and buttons you
should click.

Italic text indicates a URL (Internet address) you can access through your
browser.

Monotype  text indicates messages that appear on your computer screen.

SMALL CAPS text indicates a button on your keyboard.

Other Resources

For the latest information on RealAudio products, visit the Progressive
Networks home page at:

http://www.realaudio.com

 A technical knowledge base, frequently asked questions list, and technical
library are available from our web site at:

http://www.realaudio.com/help.html

Please refer to the enclosed Technical Support Card for more information on
contacting Progressive Networks Technical Support.
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Installing the RealAudio Player
Plus

It is strongly recommended that you use a 28.8 Kbps modem with the
RealAudio Player Plus. A 14.4 Kbps modem will limit your ability to access
much of the higher-quality RealAudio content.

You can improve the sound quality of some content by enabling the
PerfectPlay mode. Refer to “Playing Clips in PerfectPlay Mode” on page 17
for more information.

Windows 95 and Windows NT

System and hardware requirements:

• 2 MB free on your hard disk

• A Windows-compatible sound card

To play 14.4 files, you need at least: To play 28.8 files, you need at least:

• A 486/33 DX CPU

• 4 MB RAM

• 14.4 Kbps modem

• A 486/66 DX CPU

• 8 MB RAM

• 28.8 Kbps modem

When you insert the RealAudio Player Plus CD-ROM into your CD-ROM
drive, the RealAudio Installation starts automatically. The RealAudio Player
Plus is installed in the C:\RAPLAYER directory, unless you specify otherwise.
The RealAudio Installation also installs several system files into the
C:\WINDOWS\SYSTEM directory of your hard drive.

Note: For a complete list of the files that are installed, refer to the
README.TXT file installed in the C:\RAPLAYER directory.
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If the RealAudio Installation does not start automatically, perform the
following steps:

To manually install the RealAudio Player Plus:

1. Close any open applications or programs in Windows.

2. Choose Run from the Start menu.

3. Enter CD Drive:\setup.exe and click OK . (For example: D:\setup.exe)
The RealAudio Installation begins. Follow the instructions in each of the
screens that follow.

4. When the installation is complete, setup your custom Timecast page.
Refer to “Customizing Your Timecast Page” on page 12.

When the installation is complete, a shortcut for the RealAudio Player Plus is
added to your Windows 95 or Windows NT desktop.

Figure 1: RealAudio Player Plus Shortcut icon
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Windows 3.1, 3.11

System and hardware requirements:

• 2 MB free on your hard disk

• A Windows-compatible sound card

To play 14.4 files, you need at least: To play 28.8 files, you need at least:

• A 486/33 DX CPU

• 4 MB RAM

• 14.4 Kbps modem

• A 486/66 DX CPU

• 8 MB RAM

• 28.8 Kbps modem

The RealAudio Player Plus is installed in the C:\RAPLAYER directory, unless
you specify otherwise. The RealAudio Installation program also installs several
system files into the C:\WINDOWS\SYSTEM directory of your hard drive.

Note: For a complete list of the files that are installed, refer to the
README.TXT file installed in the C:\RAPLAYER directory.

To install the RealAudio Player Plus:

1. Close any open applications or programs in Windows.

2. Insert the CD-ROM into your CD-ROM drive.

3. Choose Run from the File menu.

4. Enter CD Drive:\setup.exe and click OK . (For example: D:\setup.exe)
The RealAudio Installation begins. Follow the instructions in each of the
screens that follow.

5. When the installation is complete, setup your custom Timecast page.
Refer to “Customizing Your Timecast Page” on page 12.
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Macintosh

• 2 MB free on your hard disk

To play 14.4 files, you need at least: To play 28.8 files, you need at least:

• PowerPC

• 4 MB RAM

• 14.4 Kbps modem

• PowerPC

• 8 MB RAM

• 28.8 Kbps modem

The RealAudio Player Plus is installed in the RealAudio Player folder on the
Desktop, unless you specify otherwise. The RealAudio Installation also installs
several files into the system folder of your computer.

Note: For a complete list of the files that are installed, refer to the README
file installed in the RealAudio Player folder.

To install the RealAudio Player Plus:

1. Close any open applications or programs.

2. Insert the CD-ROM into your CD-ROM drive.

3. Double-click on the CD-ROM icon.

4. Double-click RealAudio Installer. The RealAudio Installation begins.
Follow the instructions in each of the screens that follow.

5. When the installation is complete, setup your custom Timecast page.
Refer to “Customizing Your Timecast Page” on page 12.
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Customizing Your Timecast Page

Your individual customizable Timecast page is included with the purchase of
the RealAudio Player Plus. When the RealAudio Player Plus is successfully
installed, the following message appears:

Figure 2: Customize Timecast message

Click the  button. Your default World Wide Web browser opens and
welcomes you to Timecast. Customize your daily briefing following the
instructions on the page.

If you choose not to customize your Timecast page at this time, this message
reappears the next time you open the RealAudio Player Plus to enable you to
customize your Timecast page at a later time.

Note: If you upgrade or change your World Wide Web browser, you must
reinstall the RealAudio Player Plus to properly configure your browser to work
with Timecast.
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Using the RealAudio Player Plus

The RealAudio Player Plus enables you to listen to RealAudio files over the
Internet or over a local area network in real-time, without downloading the
sound clip to your hard drive. When you click a RealAudio link on a World
Wide Web page, your RealAudio Player Plus automatically opens and plays
the file you have selected. In addition, you can pause, rewind, fast-forward,
stop, and start the audio at the click of a button.

Elapsed Time/
Total Time

Volume Control

Scan Button

Link to
Progressive
Networks
Home Page

Preset Buttons

Title, Author,
Copyright text

Status Bar

Fast Forward/
Rewind Buttons

Position SliderStop Button

Play/Pause Button

Selective Record Button

Figure 3: Overview of the RealAudio Player Plus
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Section Description

Play/Pause Button This button plays or pauses a clip depending on
the status of the clip.

Selective Record Button Click the  button to save a copy of the clip on
your computer.

Note: Content providers control whether or not
you may record a clip. If you attempt to record a
clip that has this feature disabled, the  icon
appears in the upper right corner of the
RealAudio Player Plus.

Stop Button Click the  button to stop the clip.

Fast Forward/Rewind
Buttons

Click either the  button or the  button to fast
forward or rewind the RealAudio clip in 10
second intervals.

Position Slider The slider moves as a clip is being played. You
can fast forward or rewind to a different section
of the audio clip by dragging the slider.

Link to the Progressive
Networks Home Page

If you are connected to the Internet, click this
button to link to the Progressive Networks Home
Page - the Home of RealAudio. The icon
displayed changes depending on the action of the
RealAudio Player Plus. The following are the
icons that can be displayed and their meanings:

(Spinning)

Indicates that the RealAudio Player Plus is
contacting a RealAudio Server.

Indicates that the RealAudio Player Plus is
playing an audio stream.

Indicates that the clip is being recorded.

Indicates moderate packet loss, sound quality
similar to AM radio transmission.
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Section Description

Indicates high packet loss, sound quality below
AM radio transmission (garbled or choppy
speech, skipping).

Indicates that you have attempted to record a clip
that has recording disabled. Content providers
control whether or not a clip may be recorded.

Preset Buttons You can set these six buttons to automatically
link to a specific site and play a RealAudio clip.
The URL location and the label of the Preset
buttons are customized on the Preset tab of the
Preferences window.

Scan Button The  button allows you to sample
RealAudio clips, similar to scanning stations on
a radio.

Title, Author and
Copyright Text

The content provider specifies the text in these
fields; they normally describe the clip being
played.

Volume Control The volume control indicates the volume at
which the clip is being played. You can increase
the volume by dragging the control up, and
decrease the volume by dragging the control
down.

Status Bar The status bar displays the current action of the
RealAudio Player Plus. For example:
Buffering , Playing 28.8 Network
Stream , or Paused .

Elapsed Time The Elapsed Time is the length of time that the
clip has been playing.

Total Time The Total Time is the length of the entire clip.

Note: When playing a live stream, the Total
Time value displayed is 00:00.0.
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Starting a Clip

There are several ways to start a RealAudio clip:

• Click a RealAudio link on a World Wide Web page. Your World Wide
Web browser opens the RealAudio Player Plus and the audio is streamed
to the RealAudio Player Plus immediately. After storing a few seconds of
audio (buffering), the clip begins.

• Access a World Wide Web site or select an action that automatically plays
a clip. Your World Wide Web browser opens the RealAudio Player Plus
and the audio is streamed to the RealAudio Player Plus immediately. After
storing a few seconds of audio (buffering), the clip begins.

• Click the Preset or Scan buttons on the RealAudio Player Plus. The audio
is streamed to the RealAudio Player Plus immediately. After storing a few
seconds of audio (buffering), the clip begins.

• Select Open File or Open Location from the File menu on the RealAudio
Player Plus. For more information, refer to “File Menu” on page 20.

Pausing a Clip

You can pause a clip while it is playing by clicking the  button. This halts
the audio stream. If you want to resume the clip at the same point it was
paused, click the  button.

If you pause a clip but do not resume playing after several minutes, the
RealAudio Server may terminate your connection. The length of time you can
pause a clip without your connection terminating depends on the particular
RealAudio Server.

Stopping a Clip

You can stop a clip while it is playing by clicking the  button. The clip stops
playing. To play the clip again from the beginning, click the  button.
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Recording a Clip

To start recording a RealAudio clip during playback:

Click the  button. A Save As dialog box appears. Select the filename and
location on your computer where you want to save the file. When you have
finished entering this information, the RealAudio Player Plus begins recording.
While the RealAudio Player Plus is recording, the  icon appears in the upper
right corner of the RealAudio Player Plus.

Some RealAudio clips are several files played one after the other. If you chose
to save a RealAudio clip that is a compilation of several clips, a new Save As
dialog box appears at the beginning of each new clip.

Note: Content providers control whether or not you may record a clip. If you
attempt to record a clip that has this feature disabled, the  icon appears in
the upper right corner of the RealAudio Player Plus.

To start recording a RealAudio clip prior to playback:

Click the  button. Open the RealAudio clip. A Save As dialog box appears.
Select the filename and location on your computer where you want to save the
file. The RealAudio Player Plus begins recording and playing the selected clip.
While the RealAudio Player Plus is recording, the  icon appears in the upper
right corner of the RealAudio Player Plus.

Some RealAudio clips are several files played one after the other. If you chose
to save a RealAudio clip that is a compilation of several clips, a new Save As
dialog box appears at the beginning of each new clip.

Note: Content providers control whether or not you may record a clip. If you
attempt to record a clip that has this feature disabled, the  icon appears in
the upper right corner of the RealAudio Player Plus.

To stop recording:

Click the  button. The RealAudio Player Plus stops recording and playing
the RealAudio clip. If you want to continue listening to the clip, without
recording, click the  button, the clip begins playing from the beginning.
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Playing Clips in PerfectPlay Mode

PerfectPlay mode enables you to improve the sound quality by increasing the
amount of the clip that is streamed to the RealAudio Player Plus before the clip
begins playing. The time it takes to buffer the clip will be slightly longer, but
sound quality, especially with a 14.4 modem, should be improved. To return to
Regular mode, select this option again.

When you use PerfectPlay mode with a live stream, occasional gaps in the
audio will occur when your RealAudio Player Plus skips to keep up with the
connection.

To enable PerfectPlay mode:

Select PerfectPlay Mode from the File menu. If you use PerfectPlay mode
with live RealAudio content, you will experience gaps with the audio if your
connection cannot keep up with the live source.

Note: Content providers control whether PerfectPlay mode is available for a
specific clip. If you enable PerfectPlay mode, the RealAudio Player Plus
utilizes the PerfectPlay mode when it is available.

Selecting a Preset Button

Click the appropriate Preset button. The RealAudio Player Plus connects to the
corresponding site and begins playing the audio.

Setting a Preset Button

Preset Buttons are set on the Preset tab of the Preferences window. You must
enter the full URL (Internet address) of the audio clip. You can also label the
preset button.

To set a Preset Button to the clip currently being played:

Right-click (Windows) or Control-click (Macintosh) on the Preset Button you
want to set to the current clip and select Set Preset.
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Scanning RealAudio Stations

The Scan feature allows you to sample RealAudio stations, similar to scanning
stations on a radio.

To begin scanning stations:

Click the  button. The RealAudio Player Plus scans for the next station. It
plays the station for the user-defined time and then continues on to the next
station.

Note: You define the amount of time that each station is played on the Preset
tab of the Preferences window.

To stop scanning and listen to current station:

Click the  button.

To set a Preset Button to the station currently being played:

Right-click (Windows) or Control-click (Macintosh) on the Preset Button you
want to set to the current station and select Set Preset.

To return to a previous station:

Select Previous Clip from the Clip menu or press PAGE UP.

To skip to the next station:

Select Next Clip from the Clip menu or press PAGE DOWN.

To stop scanning and stop listening to the current station:

Click the  button.
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RealAudio Player Plus Menus

The RealAudio Player Plus has five menus: File, View, Clip, Sites, and Help.
These menus allow you to take full advantage of the RealAudio Player Plus
features.

File Menu

Commands from the File menu allow you to play RealAudio files without
using your World Wide Web browser to find files on the Internet, to enable
PerfectPlay mode, and to exit the RealAudio Player Plus.

Figure 4: File menu

Menu Option Description

Open Location… Select this option to play RealAudio files
through the Internet without using your World
Wide Web browser. The Open Location dialog
appears, enter the URL (Internet address) of a .ra
or .ram file.

Open File… Select this option to play a local RealAudio file.
The Open File dialog appears, select a .ra or
.ram file stored on your computer.
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Menu Option Description

Open Recent Select this option to view a list of recently
played clips. You can select a clip from this list
to hear the clip again.

PerfectPlay Mode Select this option to switch to PerfectPlay mode;
a check mark appears next to the option. This
mode enables you to improve the sound quality
by increasing the amount of the clip that is
buffered. The time it takes to buffer the clip will
be slightly longer, but sound quality, especially
with a 14.4 modem, should be improved. To
return to Regular mode, select this option again;
the check mark is removed.

When you use PerfectPlay mode with a live
stream, you may experience occasional gaps in
the audio when your RealAudio Player Plus skips
to keep up with the network.

Close Window
(Macintosh Only)

Select this option to close a secondary window,
such as the Connections Statistics window.

Exit/Quit Select this option to exit the RealAudio Player
Plus.
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View Menu

Commands from the View menu allow you to control the appearance, to
customize the operation, and view the performance of the RealAudio Player
Plus.

Figure 5: View menu

Menu Option Description

Presets & Scan Select this option to display the Preset and Scan
buttons on the RealAudio Player Plus; a check
mark appears next to the option. Select the
option again to hide the buttons; the check mark
is removed.

Info & Volume Select this option to display the volume control,
and the title, author, and copyright information
for the clip; a check mark appears next to the
option. Select the option again to hide the
information; the check mark is removed.

Status Bar Select this option to display the Status Bar; a
check mark appears next to the option. Select the
option again to hide the bar; the check mark is
removed.
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Menu Option Description

Preferences… Select this option to display the Preferences
window for configuring the RealAudio Player
Plus. You can set preferences from this window.
For more information, refer to “Setting
Preferences” on page 28.

Note: This option is on the Edit menu in the
Macintosh version of the RealAudio Player Plus.

Statistics/Connection
Information

Select this option to display the transmission
quality information in the Connection Statistics
dialog. The Connection Statistics window reports
the performance of the Internet connection
between the RealAudio Server and the
RealAudio Player Plus. Refer to Figure 6 for an
example of the Connection Statistics window.

Always on Top
(Windows Only)

Select this option to make the RealAudio Player
Plus remain on top of all other windows, even
when another window is active; a check mark
appears next to the option. Always on Top is
convenient for keeping the RealAudio Player
Plus visible while you interact with your World
Wide Web browser. Select this option again to
allow other windows to open on top of the
RealAudio Player Plus; the check mark is
removed.
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Figure 6: Connection Statistics window
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Clip Menu

Some RealAudio clips are several files played one after the other. Commands
from the Clip menu allow you to move between clips in a multi-clip
RealAudio (.ram) file and when scanning. They are similar to seek buttons on
a CD player. If there is only one RealAudio clip at the link you are accessing,
these options are not available.

Previous Clip and Next Clip are also available from the shortcut menu that
appears when you right-click (Windows) or control-click (Macintosh) the
mouse button in the RealAudio Player Plus window.

Figure 7: Clip menu

Menu Option Description

Previous Clip Select this option to play the previous clip in a
multi-clip RealAudio (.ram) file or when
scanning.

Next Clip Select this option to play the next clip in a multi-
clip RealAudio (.ram) file or when scanning.



REALAUDIO PLAYER PLUS GETTING STARTED GUIDE

26

Sites Menu

Commands from the Sites menu allow you to access various pages at the
Progressive Networks and Timecast World Wide Web sites. This feature works
with popular World Wide Web browsers including Netscape Navigator,
Internet Explorer, Mosaic, Spyglass Mosaic, and Spry Mosaic. If you are
connected to the Internet, and your World Wide Web browser is not open, the
RealAudio Player Plus opens it for you.

Note: You must be connected to the Internet in order to reach these sites.

Figure 8: Sites menu

Menu Option Description

RealAudio Home Page Select this option to access the Progressive
Networks’ Home Page.

Timecast: The RealAudio
Guide

Select this option to access Timecast: the
RealAudio Guide. Timecast contains a list of
World Wide Web sites providing RealAudio
content.

RealAudio Help Page Select this option to access the RealAudio main
help page.

Scan: Show Stations Select this option to access the RealAudio Scan
Stations page. This page displays a list of the
stations that will be played while scanning.
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Help Menu

Commands from the Help menu provide you with online help and information
about the RealAudio Player Plus.

The latest support and technical information is available at:

http://www.realaudio.com/help.html

Please refer to the enclosed Technical Support Card for more information on
contacting Progressive Networks Technical Support.

Note: The Macintosh version of the RealAudio Player Plus does not have a
Help menu.

Figure 9: Help menu

Menu Option Description

Contents Select this option to open the online help for the
RealAudio Player Plus.

About… Select this option to display the RealAudio
Player Plus version and Copyright information.
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Setting Preferences

You can customize the RealAudio Player Plus by changing the settings in the
Preferences window. The Preferences control various aspects of the RealAudio
Player Plus functionality such as the number of clips to remember, network
information, and proxy information.

General Preferences

The General tab in the Preferences window contains preferences for clip
memory, Synchronized Multimedia support, and CPU usage.

Figure 10: General tab in the Preferences window
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Field Description

Slider Seek Time
(Macintosh Only)

Enter the number of seconds you want to move
backward or forward when you press the Rewind
or Fast Forward buttons.

Remember the Most
Recent Clips

Enter the number of clips that you want the
RealAudio Player Plus to remember and display
when using the Open Recent option on the File
menu.

Synchronized Multimedia Click this box to enable Synchronized
Multimedia; a check mark appears in the box.
When this option is enabled, the RealAudio
Player Plus can trigger new World Wide Web
pages during a RealAudio Synchronized
Multimedia clip, thus providing a narrated slide
show.

You can disable this option by clicking the field
again; the check mark is removed. When this
option is disabled, the RealAudio Player Plus is
unable to display visual content in Synchronized
Multimedia sound clips.

Audio Quality versus
CPU Usage

You can move the slider to control the Audio
Quality versus CPU Usage. To achieve the best
sound quality from the RealAudio 28.8
algorithm, your computer needs to quickly
process a large quantity of data. If your machine
experiences a decrease in performance while
playing a RealAudio file, slide this bar to change
this setting. You will need to experiment to
discover the best setting for your machine and
Internet connection.

PerfectPlay: Buffer
Seconds of Audio Before
Player

Enter the amount of time (in seconds) the
RealAudio Player Plus should buffer the clip
before playing.



REALAUDIO PLAYER PLUS GETTING STARTED GUIDE

30

Network Preferences

The Network tab in the Preferences window allows you to customize your
network connection for the RealAudio Player Plus.

The descriptions of these preferences assume a basic knowledge of Internet
protocols and firewalls. For more information about firewalls, refer to our
World Wide Web site at http://www.realaudio.com/firewall.html.

Figure 11: Network tab in the Preferences window
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Field Description

Receive Audio Via Select UDP (User Datagram Protocol) or TCP
(Transmission Control Protocol) as the method
for receiving audio. By default, the RealAudio
Player Plus receives data packets using UDP. If
you cannot receive UDP packets because you are
behind a packet-filtering firewall, set this
preference to TCP.

Note: If you use TCP with a modem, you may
experience gaps in the audio stream.

Use Specified Port Click this field if you want to configure the
packet-filtering firewalls to receive UDP through
one specified port. Enter the port number. The
RealAudio Player Plus can receive UDP packets
through any designated port between 1000 and
9999. Your firewall administrator should tell you
what port to specify.

Note: RealAudio TCP packets are only received
through Port 7070.

Server Timeout Enter the maximum number of seconds the
RealAudio Player Plus should wait to connect to
a RealAudio Server. If it does not connect within
the specified time period, a Retry/Cancel
message is displayed. A value of 0 means that
the RealAudio Player Plus never times out.
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Field Description

Send Statistics Click this field if you want the RealAudio Player
Plus to send connection quality statistics to the
RealAudio Server after playing a clip.

This feature helps content providers assure
transmission quality. This information is
basically what you see in the Connection
Statistics dialog and includes the number of
packets received, lost in transmission, arrived
late, arrived early, and arrived out of order.

Note: The RealAudio Player Plus does not
access or send the Server any information about
your identity (your user name or e-mail address).

Loss Correction Click this field if you want the RealAudio Player
Plus to compensate for packets lost in
transmission between the RealAudio Server and
your RealAudio Player Plus. You may hear a
momentary warble in the audio stream if packets
are missing.

When Loss Correction is unchecked, the lost
packets are dropped, causing a skip.

Bandwidth Select the appropriate bandwidth of your Internet
connection.
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Proxy Preferences

A proxy is a server that acts as an intermediary between a company's protected
LAN and the Internet. For more information about proxies and firewalls, read
http://www.realaudio.com/firewall.html. The proxy server insures that all data
transmission between the Internet and a user on the LAN is authorized. The
RealAudio Player Plus can be configured to work with proxy servers by setting
the proxy preferences.

Figure 12: Proxy tab in the Preferences window

Field Description

Use Proxy Click this box if the RealAudio Player Plus
should connect to the Server using a proxy; a
check mark appears in the field. Otherwise, do
not click this box.

Note: If you are behind a firewall and do not
know the host name or port number of your
proxy server, ask your firewall administrator.
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Field Description

RealAudio Proxy Enter the domain name or IP address of the
RealAudio proxy server and port number that the
RealAudio Player Plus should use to
communicate with the proxy server.

Note: For information on RealAudio Proxy, read
http://www.realaudio.com/firewall.html

HTTP Proxy Enter the domain name or IP address of the
HTTP proxy server and port number that the
RealAudio Player Plus should use to
communicate with the proxy server. Check your
World Wide Web browser’s proxy configuration.

No Proxy for: [Host 1,
Host2…]

If you have specified that the RealAudio Player
Plus should be connected to the Server using a
proxy, you can specify certain local hosts
(domain names or IP Addresses) with which you
do not need to communicate using the proxy
server. Enter these hosts in this field. This field
is only available if you have enabled the Use
Proxy option.

Your firewall administrator can provide you with
this information, if appropriate.
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Advanced Preferences

Options on the Advanced tab of the Preferences window override the
RealAudio Player Plus defaults for sound card compatibility. You don’t need
these options unless you are having troubles with sound quality. Refer to
“Troubleshooting” on page 39 for more information.

Note: The Macintosh version of the RealAudio Player Plus does not have an
Advanced Preferences option.

Figure 13: Advanced tab in the Preferences window
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Field Description

Use 8-bit Only Click this field if you want to force your sound
card to play only 8-bit sound; a check mark
appears. Use this option only if there is evidence
of compatibility problems with your sound card.
The RealAudio Player Plus normally delivers 16-
bit audio to the sound card. The RealAudio
Player Plus should automatically detect if the
sound card only supports 8-bit audio, and then
deliver 8-bit audio.

Use 11 kHz Only Click this field if you want to force your sound
card to play only 11 kHz sound; a check mark
appears. Use this option only if there is evidence
of compatibility problems with your sound card.
The RealAudio Player Plus normally delivers 8
kHz audio to the sound card. If your sound card
does not support the 8 kHz sampling rate, the
audio may sound high-pitched or too fast. When
this option is selected, the RealAudio Player Plus
changes audio to 11 kHz before delivering it to
the sound card. This option increases CPU usage
slightly.
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Language Preferences

The setting on the Language tab of the Preferences window determines the
language used within the RealAudio Player Plus.

Note: The Macintosh version of the RealAudio Player Plus does not have a
Language Preferences option.

Figure 14: Language tab in the Preferences window

Field Description

Current Language This field displays the language being used
within the RealAudio Player Plus

Installed Languages Select the language you want to use within the
RealAudio Player Plus menus and windows.

Note: Please contact Progressive Networks
regarding information on languages available for
the RealAudio Player Plus.
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Presets Preferences

Using the Presets tab of the Preferences window, you can modify the label of
the Preset buttons and the URL corresponding to that Preset button. You can
also set the length of time each clip is played while scanning clips.

Figure 15: Presets tab in the Preferences window

Field Description

Label Enter the text string you want to appear as the
label of this Preset button.

URL Enter the URL (Internet address) you want to
play when this Preset button is clicked. You must
enter the full URL. For example:
http://cgi2.prognet.com/plus/preset1.ram

Play Each Scan Clip for
Seconds

Enter the amount of time (in seconds) the
RealAudio Player Plus should play each clip
when scanning.
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Solving Problems

For the latest information on RealAudio products, visit the Progressive
Networks home page at:

http://www.realaudio.com

A technical knowledge base, frequently asked questions list and technical
library are available from our web site at:

http://www.realaudio.com/help.html

Please refer to the enclosed Technical Support Card for more information on
contacting Progressive Networks Technical Support.

Troubleshooting

How do I configure my browser to support RealAudio?

With most browsers, the RealAudio Player Plus installation configures the
browser to support RealAudio. If you change your browser and it stops
recognizing RealAudio files, reinstall the RealAudio Player Plus. To manually
configure your World Wide Web browser, do the following:

1. Open the Options or Preferences or Settings menu.

2. Select the Helper Applications or similar option.

3. Look for "audio/x-pn-realaudio" in the File type list. If an entry exists,
select the entry.

 Otherwise, click New Type. Enter audio as the Mime Type. Enter
x-pn-realaudio as the Mime SubType. Click OK .
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4. Enter ra,ram  in the Extensions field.

5. Select the Launch Application option. Browse and find the directory in
which the RealAudio Player Plus is installed.

6. Select RealAudio (raplayer.exe) as the application to launch.

What's wrong when the sound is poor?

The sound quality should be similar to FM mono. If the sound quality is below
AM radio transmission (garbled or choppy speech, skipping, etc.), use the
following to isolate and correct the problem. If the audio quality was poor
when the "Setup is Complete" file was played (during the RealAudio Player
Plus installation), try configuring the RealAudio Player Plus or your sound
card.

If the audio quality was poor from a particular site, use the Connection
Statistics window in the RealAudio Player Plus to check for lost packets. If the
packet loss is high, it may be due to a busy network. Select PerfectPlay Mode
from the File menu or connect to the site at a later time.

If the audio quality is poor on every site, do the following:

1. Check the actual modem connection speed. This may be shown in the
lighted display for external modems, or through an information window if
you have an internal modem (check the user manual for your modem).
Sometimes service providers use a lower rate connection speed such as
14.4, so even though you are dialing in on a 28.8 modem, you are only
receiving data at 14.4 Kbps.

2. For a 14.4 connection on an Apple Duo, go to the modem properties
window and turn off the compression control. Compression uses CPU
cycles that the RealAudio Player Plus may need. Since RealAudio files are
already compressed, this utility is not necessary. Turning off compression
will not affect your computer's other operations.

3. If you are using an external modem with a Windows PC and the
Connections Statistics window shows minimal packet loss (10% or less),
there may be a problem with the speed at which packets are transferred
between the modem and serial card. Try setting the port speed higher (at
least twice the modem speed).
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Why doesn’t my RealAudio Player Plus have a Volume
Control slider?

If the sound card installed in your computer does not support volume control,
the Volume Control slider does not appear on the RealAudio Player Plus.

What causes RealAudio clips to occasionally skip?

There are two possible reasons:

• Starting or quitting large applications while playing RealAudio can cause
a brief disruption of the playback.

• When you use PerfectPlay mode with a live stream, occasional gaps in the
audio will occur when your RealAudio Player Plus skips to keep up with
the network.

Why can’t I play RealAudio clips on my computer at work?

If you're on a local area network which is attached to the Internet, and are
unable to play RealAudio files from remote Web sites, it's possible that your
company's firewall is preventing the RealAudio stream from reaching you.
Users can receive live and on-demand audio from the Internet without
exposing their company's network to security risks.

If your computer is behind a firewall, please see Progressive Networks’
firewall page for more information: http://www.realaudio.com/firewall.html



REALAUDIO PLAYER PLUS GETTING STARTED GUIDE

42

Index

A
ActiveX, RealAudio Control, 2

C
Clip Menu, 21
Clips

pausing, 13
recording, 14
starting, 13
stopping, 13

Configuring browsers, 35
Connection Statistics window,

20
Customizing, Timecast, 8

D
Documentation Conventions, 3

F
File Menu, 17
Firewalls, 37

H
Help Menu, 23

I
Installing, 4

Macintosh, 7
Windows 3.1, 3.11, 6
Windows 95/NT, 4

M
Macintosh, installing, 7
Menus

Clip, 21
File, 17
Help, 23
Sites, 22
View, 19

P
Pausing a Clip, 13
PerfectPlay Mode, 15, 18
Plug-in, RealAudio, 2
Preset Button

changing, 15
selecting, 15
setting, 15

R
RealAudio Control for

ActiveX, 2
RealAudio Player Plus

overview, 9
using, 9

RealAudio Plug-in, 2
RealAudio Xtra for

Shockwave, 2
Recording a Clip, 14

S
Scanning RealAudio Clips, 16
Setting Preferences, 24

advanced, 31
general, 24



INDEX

43

languages, 33
network, 26
Presets, 34
Proxy, 29

Sites Menu, 22
Solving Problems, 35
Starting a Clip, 13
Stopping a Clip, 13

T
Technical Support, 3, 23, 35
Timecast, 2

customizing, 8

Troubleshooting, 35

V
View Menu, 19

W
Windows

Connection Statistics, 20
Windows 3.1, 3,11, installing,

6
Windows 95, installing, 4
Windows NT, installing, 4


